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Overview of GIS Integration
Functionality

The Oracle Utilities Work and Asset Management GIS integrations provide a way to navigate between the
Oracle Utilities Work and Asset Management application and external GIS data. This guide provides a
general overview of all GIS integrations supported by Oracle Utilities Work and Asset Management.

For detailed information on a specific viewer, please refer to the User Guide for that viewer.

e AutoDesk (MapGuide) User Guide
*  Intergraph (Geomedia) User Guide
*  ESRI (ArcIMS) User Guide

*  ESRI (ArcMap) User Guide

*  Oracle GIS Viewer User Guide

GIS Functionality

Use a GIS viewer to view and manipulate asset and maintenance information based on geographic
location. Two way communication between the applications allows you to launch a map viewer and “zoom
in” on specific Oracle Utilities Work and Asset Management Asset, Work Order, Work Request, PM
Master, or Service Request records. You can also launch Oracle Utilities Work and Asset Management
from the map viewer. GIS extensions integrate through:

Linked Data - Your system administrator links Oracle Utilities Work and Asset Management Asset
and Tax ID records to the appropriate features on the GIS map.

Actions/Menus - The Actions list in Oracle Utilities Work and Asset Management enables you to
view and print maps of assets and service request addresses. From the GIS application, a custom
Oracle Utilities Work and Asset Management menu enables you to plan work related to assets, create
service requests, record assets on service requests, and open Oracle Utilities Work and Asset
Management to specific records listed in the map viewer.

Data Sharing - As you work, data is updated in both applications.

Permissions

Settings in the GIS Setup business rule determine which GIS Viewer is used. This setting can be
over-ridden in each individual user profile by adding the ACTIVATED GIS OPTION key name. The
appropriate additional settings must be defined in the business rule so that users can switch viewers.

Responsibility functions must also be added to the user profile of anyone who will need access to the view
and print GIS actions available in modules as well as to have access appropriate viewer:

*  GIS VIEWER - Add responsibility function to allow access to the Oracle GIS Viewer.
e VIEW GIS - Add responsibility function to allow access to the print and view GIS actions
available in modules. (Must be added regardless of which viewer is used.)
Please refer to GIS Implementation for more information.
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Viewing and Printing Maps

Daily Use of a GIS Viewer

Use GIS functionality in daily work to:

*  View and print maps of assets or service request addresses.

e Plan work by viewing existing work records associated with assets. You can also create new Work
Order or Service Request records as needed.

*  Update asset assignments directly on the map to reflect work done. You can also create Asset
records.

*  Record assets on service requests to apply service request costs to those assets. You can also
create service requests from the map viewer.

Map Viewer

Depending on which viewer your organization uses and how it is configured, you can select GIS Viewer
from the home page Actions list, select a link from the home page Links component, or you select View
GIS from the Actions list in one of the supported modules.

Users can also add a link to their home page to launch the map viewer.

Regardless of the viewer you are using, you will find a map display, a toolbar with pan and zoom controls, a
menu and a theme selections panel that controls which map features display.

Functionality

As you move the mouse pointer over a feature on the map, the feature is highlighted and a
pop-up label displays the Asset number for the object if one has been assigned. The viewer has
various controls for manipulating the map image and selecting or deselecting assets.

Regardless of which module you were using when you launched the viewer, asset data is required
for the viewer to locate a specific location. If no asset data is available on the record when you
select View Map from the Actions list, a large-scale map opens in the viewer. You can then use
the viewet's pan, zoom and search controls to locate desired features.

Viewing and Printing Maps

As long as an asset has been assigned to one ot mote map featutes, you can view and print a map of the
asset. This can be done from any one of the supported modules.

Applicable viewers are best used when launched from the module where the assigned assets are referenced.
Use similar procedures to view maps from Assets, Work Orders, Work Requests, PM Masters and Service
Requests.

If the asset is not assigned to a feature on the map, the map opens displaying a warning that no item is
selected.

Note: If you have previously launched the viewer and it is running in the background behind the Oracle
Utilities Work and Asset Management application, clicking on the View Map option will not reopen the
viewer. To open the viewer when it is running in the background, click on the map viewer icon on the
windows toolbar.

View a single asset

Open the appropriate record then select View GIS Map from the Actions list. The system opens the
viewer with the asset selected.

How to View a Map of an Asset Record

View multiple assets
Create a search in the Asset module then select View GIS Map from the Actions list on the results of
search screen. The resulting map shows all of the Assets from the results list, as applicable.
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Assign/Unassign Assets

View customer addresses
From the Service Request module you can select View Map (Tax ID) to open a map of the customer’s
address on the service request.

Printing maps

Select Print GIS Map from any of the eligible modules and the system opens the map and provides
prompts to walk you through the process of printing the map. This option is available from the header or
the results of search screen so that you can print a single asset or multiple assets.

How to Print a Map of an Asset Record

Creating Records from Map Objects

To create new records you can select one or multiple objects on the map then click the desired menu item
and select Create.

When you create new records from GIS, the system uses the Default Name in the user profile of the logged
on user to populate the Dispatcher, Requestor, and Initiator fields on the Service Request, Work Order and
Work Request, respectively.

Please refer to the Details on Each Integrated GIS System to confirm whether or not your viewer can
perform the create action as described below.

Asset - The system creates an asset record based on the selected feature on the map. Only ArcView and
Geomedia users can create new assets.

PM Master - You can not create new pm masters from a viewer. Only view.

Service Request - The system creates one Service Request record with every selected map object.
These assets are then listed in the Service Request Asset List view:

Work Order - When you select Create (multi tasks) the system creates one Work Order record with a
separate task for each selected map object. Selecting Create (single task) creates one Work Order record
with one task listing all selected assets in the Asset List.

Work Request - The system creates one record for the selected map object. You can only create one
Work Request at a time.

How to Create an Asset Record from the GIS Map
How to Create a Work Order from the Map Viewer
How to Create a Service Request from the GIS Map

Recording Assets

When you launch a GIS viewer from a Service Request record, you can select one or more Assets on the
map the select Record Assets from the Menu under Service Request. The system adds the selected assets to
the Service Request that you were viewing when you launched the viewer.

As work progresses on the service request, costs are applied to the assets according to the percentage split
entered. Assets can have parent/child relationships with other assets. Costs associated with a child asset
roll-up the asset hierarchy to the parent asset, along with other child asset costs.

How to Record Assets on a Service Request

Assign/Unassign Assets

After you perform work on assets to repair or upgrade equipment, you may need to modify or update asset
assignments on the GIS map. For example, after repairing a broken pipe, you may want to unassign and
de-activate the previous asset record, create new asset records, and assign the new asset records to each
section of the broken pipe.

Oracle Utilities Work and Asset Management GIS enables you to unassign, de-activate, assign, and create
Oracle Utilities Work and Asset Management Asset records from the GIS application.
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Map Tools

How to Assign an Asset ID to a Map Feature
How to Unassign an Asset ID
How to Assign a Parent Asset

Map Tools

Hover over the icons in the toolbar to discover the function of each tool. Refer to the product guide for
your specific GIS viewer for more detailed information on these tools. These tools only manipulate the
image without resulting in any geo-spatial or database changes.

Pan and Zoom

All viewers have a drag or pan tool, zoom in and zoom out tools to allow you to manipulate the visual
display of the map. Select the tool then click or drag on the map to reposition or zoom to the desired effect.
Some viewers also include a zoom slider which can be used to zoom in and out by moving the slider up or
down.

Select

Click one of the features tools, (Select Point, Select Rectangle, or Select Circle) then click or draw the shape
around a map feature to select that map feature. Select Rectangle or Circle allow you to select more than
one map feature. You can also hold down the shift key and use Select Point to select multiple features.
When you release the mouse button, the features are selected.

Search

Click on the Search tool to display a dialog where you can enter search criteria to find a map feature. Search
by any combination of criteria such as layet, field or theme and enter a value or leave the value blank to
search for all.

Selecting Features from the Map

When the GIS viewer is open, you can select one or multiple objects on the map then select View under the
applicable menu option to open a results of search screen listing all of the related records referencing the
selected objects.

This can help you to rather information relevant to work you need to perform on assets. You can view
details about the assets or view a list of work orders. In this way, you can easily find out if there are existing
plans to work on the assets or if a new work order needs to be created. If a work order or service request
need to be created, you can also do this from within the map viewer, if the viewer supports this
functionality.

How to View Asset Details from the Map Viewer
How to View Work Records Associated with a Map Feature

Layer Selections
You can turn layers on and off by clicking the check boxes associated with each layer. After adding or
removing a layer, you may need to click the refresh icon to see the change.

Searching the Map

In addition to searching for map features from within the Oracle Utilities Work and Asset Management
application, the HTML map viewer also allows you to search for specific addresses, intersections, and
patcels directly from the map viewer. The search feature is particularly useful if you launch the map viewer
from a link on your home page, rather than from a Oracle Utilities Work and Asset Management asset or
work record. The Java map viewer does not support these additional search capabilities.

Note: These are not geospatial searches. Your GIS data must be setup for tabular searches in order to
support this functionality.

How to Search for an Address
How to Search for an Intersection
How to Search for a Parcel
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Details on Each Integrated GIS System

Intensity Mapping

You can use Intensity Mapping to display selected assets on the map in different colors based on a
particular Oracle Utilities Work and Asset Management context, such as number of Work Orders. Intensity
Mapping can supply a quick visual indication of which Assets are incurring the highest incidence of repair.
You define ranges used for the three available colors. The colors used in by the Intensity Mapping function
are defined system-wide by the administrator.

Intensity Mapping is only used in Intergraph Geomedia to view Work Orders and Service Requests. After
petforming a Oracle Utilities Work and Asset Management search, launch the viewer from the Results of
Search screen and click on the Intensity Map icon.

How to View Work Order using Intensity Mapping (Intergraph only)

Details on Each Integrated GIS System

While these applications function in the same way overall, there are slight differences between the different
GIS products which are available to be integrated with Oracle Utilities Work and Asset Management.

Please refer to the specific product guide for user interface details or a description of the available tools and
functions.

Comparison of Functionality

The supported GIS products offer similar, but not identical feature sets. A consistent effort is made to
support the same functionality in all integrations, however due to the unique characteristics of the GIS
products, this is not always possible. The following table summaries the functionality available in each of
the current integrations.

AutoDe_sk ESRI1 ( :imzs / Interg rap_h O_racle
(MapGuide) (ArcMAP) ArcGIS) (GeoMedia) Viewer
Asset ID displays on map (always
visible) v v v
Asset ID displays on map (on
mouse over) v v v
Asset: Assign / Unassign to map
feature v v
Asset: Assign parent asset v
Asset: Create from map v v
Asset: Open record from map v v v v v
Asset: Record on Service
Request v v v v v
Asset: View by Tax ID v v v v v
Asset: View multiple selected on
map v v v v v
Intensity Mapping v
Map Layers v v v v v
PM Master: Open record from
map v v v v v
Search/Query the map v v
Service Request: Create from
map v v v v
Service Request: Open record
from map v v v v v
Thematic Mapping v
View / Print map from header v v v v v
View / Print map from results of
search v v v v v
Work Order: Create from map v v v v v
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Details on Each Integrated GIS System

ESRI2
AutoDesk ESRI1 (ArcIMS/ Intergraph ~ Oracle

(MapGuide) (ArcMAP) ArcGIS) (GeoMedia) Viewer

Work Order: Open record from

map v v v v v
Work Request: Create from map v v
Work Request: Open record from

map v v
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Tutorials

This section shows steps to complete some of the most common GIS features. This is a general guideline

for any GIS viewer.

How to View a Map of an Asset Record

1.

Open an appropriate Asset record or Asset Results of Search screen.
From the Service Request header record, select View Map (Tax ID) to view a map of the customer’s
address on the Service Request.

If you view a map from a module other than the Asset module, it will show the mapped Assets
associated with that module. A map opened from the Work Order Module, or example, shows the
Asset listed on the selected Work Order.

Select View GIS Map from the Actions list.
If the Asset is not assigned to a feature on the map, the GIS map opens and displays a warning that no
item is selected.

When you select View Map, the map viewer opens a map showing the feature that the Asset is
assigned to. If you select View GIS Map from a Results of Search screen, the map viewer opens
showing all the mapped assets retrieved by your search.

The first time you open the map viewer in a work session, you will see the following message while the
map is updated. After the map loads, click on the OK button to clear the message.

Reposition the map as needed.
Rest the mouse pointer over any tool icon to see a popup description of what the tool does.

Use the Pan or Zoom tools from the control panel to reposition the map.

You can then select Print or Print Preview from the File menu to print the map, or you can print the
map from as shown in the following steps.

How to View Asset Details from the Map Viewer

1.

Select a feature on the map that has an assigned asset ID.

You can select more than one feature by using the viewer’s Select by Rectangle or Select by Circle
controls. Click the tool to select it from the control panel and then draw the corresponding shape
around the map features you want to select.

You can click the Print button to print a list of the Work records displayed, or click the record number
to open that record in Oracle Utilities Work and Asset Management.

Some menu selections may be unavailable depending on which map feature(s) are selected.

Select View under Asset on the map viewer’s Options menu.
The View Asset window opens with details about the Oracle Utilities Work and Asset Management
Asset record(s).

You can click the asset ID number on the View Asset screen to open Oracle Utilities Work and Asset
Management to that Asset record.
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If you have selected more than one asset in the map feature, the Asset module results of search
window opens, where you can select the asset record to view.

Remember that map features must have assigned asset IDs in order for them to display in the Oracle
Utilities Work and Asset Management window. If you select nine map features, but only five have asset
IDs, only those five will display on the results of search page.

How to Print a Map of an Asset Record

1.
2.

Open the appropriate Asset record.
Select Print GIS Map from the Actions list.
The GIS application launches and opens a print dialog box for printing a map of the assigned asset.

Reposition the map if necessary.
Skip this step if you do not need to reposition the map before printing,

To reposition the map, click the Close button to close the Print dialog box. Select the Pan, Zoom In,
and Zoom Out controls as needed to reposition the map. When done, select Print from the map
viewet’s File menu to reopen the print dialog box.

Specify a Printer and Print Options and click OK.
The map prints to the printer specified.

You can use similar steps to print maps from the Work Order, Benchmark Work Order, PM Master,
and Service Request modules. From the Service Request module, you can also select Print Map (Tax
ID) to print a map of the customer’s address on the service request.

How to View Work Records Associated with a Map Feature

1.

Select one or more features on the GIS map.
The menu option is only available when at least one feature has an assigned Oracle Utilities Work and
Asset Management Asset 1D.

Select PM Master, Service Request, Work Order, or Work Request on the Options menu in the map
viewer.

Click View.

The corresponding search dialog box opens.

Enter search criteria.
The drop-down list for the Selected Assets field includes all the assets selected from the map.

Click the Search button.
The search results display.

If only one work record is found, that record opens in the Oracle Utilities Work and Asset
Management window.

If more than one corresponding record is found, a results of search window opens showing the
appropriate records. matching your view request, You can then select the record you want to view.

If you want to modify your search, click on Search Options button to open the Oracle Utilities Work
and Asset Management search screen, where you can edit or delete the Custom SQL statement for the
current search. You can also modify your search by returning to the map viewer and selecting other
map features you want to view.

You can click the Print button to print a list of the work records displayed. Then open the appropriate
module to view more information about specific records.

How to View Work Order using Intensity Mapping (Intergraph only)

1.
2.

Select the appropriate Asset(s) on the map display.

Select View Work Order or View Service Request from the Oracle Utilities Work and Asset
Management menus.

The viewer opens either the View Work Order or the View Service Request selection window.

Check the Show Intensity Map box under Options.
Define the ranges you want to display.
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As you adjust the values for Range 2, the upper value of Range 1 and the lower value of Range 3
adjust accordingly when you click outside the box. Each range will display in a different color on the
map.

Click on the Search button.
The viewer opens the view results window showing both the standard View Work Order table and the
Intensity Map.

If you want to refine the Intensity ranges on this map, click on the Back button to return to the
previous screen and make the necessary adjustments in the range definitions. Then click on the Search
button to redisplay the map.

How to Create an Asset Record from the GIS Map

1.

Select a feature on the map that has not been assigned an asset ID.
Click on the Select Features tool and then click on the map feature you want to select.

Make sure that you select only one feature, and that the feature does not already have an assigned
asset. Otherwise the Create option will be greyed out.

Select Create Asset from the Oracle Utilities Work and Asset Management Asset menu.
The Create Asset dialog box opens.

Enter basic information to create the Asset record.
The system displays a warning if the asset ID that you enter already exists.

The system fills in the Plant field. The Plant, Record Type, Asset ID, and Asset Type fields are
required. All information entered here will be included on the Asset record you create.

Click on the Create button.
The system confirms that the asset has been created successfully and places the Oracle Utilities Work
and Asset Management Asset record in Inactive status.

Click OK.
The system asks whether you want to assign the asset to the selected feature.

Select Yes or No as appropriate, then click OK.
If you select Yes, the system labels the selected feature with the asset ID.

To view or modify the Asset record, open the Asset ID record in Oracle Utilities Work and Asset
Management.
The Asset module is located in the Resource subsystem.

How to Create a Work Order from the Map Viewer

1.

Select one or more assets on the map.
If you select several assets, the work order will be created with one task for each asset.

Select Create from the Work Order options menu.
The Create Work Order dialog box opens with information about the Plant, the Selected Asset(s), and

the Current User. This information will be used on the Oracle Utilities Work and Asset Management
Work Order record that will be created.

Enter a description.
This will be the description on the Oracle Utilities Work and Asset Management Work Order record.

Select the Create WO button.

The system creates a Oracle Utilities Work and Asset Management Work Order record in Planning
status and provides the new work order number. One task is created for each asset that was selected.
You can update the record with additional information as necessary

To modify the work order, open the record in Oracle Utilities Work and Asset Management and make
any necessary changes.

Follow similar steps to create a work request from the map viewer. However, you can select only one
asset when creating a work request.
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You can select several assets
on the map to create a service
request listing each asset.

How to Create a Service Request from the GIS Map

1.
2.

Select one or more assets on the map.
Select Create Service Request from the Oracle Utilities Work and Asset Management Service Request
menu.

The system displays a message confirming the selected asset(s).

Click on the Yes button to create the Service Request.
The Service Request module opens showing the Service Request record created.

If you selected more than one asset in Step 1, you can open the Service Request Asset List view to see
a listing of the assets included and the percentage split between assets.

Review and update the record as necessary.

Once the record is open in Oracle Utilities Work and Asset Management, all Oracle Utilities Work
and Asset Management functionality is available. In addition to adding additional data to the record,
you can also check for duplicate service requests, adjust the percentage split between assets, and do
other work as appropriate.

Click on the Save icon.

How to Assign an Asset ID to a Map Feature
You can assign an asset to one or more features on the map, but you must assign the asset to one feature at

a time.

1.

Select a feature on the map that has not been assigned an asset ID.
Make sure that you select only one feature, and that the feature does not already have an assigned
asset. Otherwise the Assign option will be greyed out.

Select Assign Asset from the Oracle Utilities Work and Asset Management Asset menu.
The Assign Asset dialog box opens.

Enter criteria to search for the Oracle Ultilities Work and Asset Management Asset record.
You can enter search criteria in the fields in the upper portion of the window. List of Values are
available.

Click the Search button.
If you need to modify the search criteria, select the Clear button to clear the fields in the upper
portion of the window, enter new search criteria, and click the Search button again.

Search results display in the lower portion of the window.

Highlight the Asset record you want to assign.
Click the Assign button.
The system displays a message requesting confirmation.

Click on the Yes button to confirm.
Click on the OK button.
The system closes the dialog box and labels the map feature with the Asset record ID as shown below.

How to Unassign an Asset ID

1.
2.

Select a feature on the map that has been assigned an Asset record.

Select Unassign Asset from the Oracle Utilities Work and Asset Management Asset menu.

If an Asset tecord has not already been assigned to the selected feature, the Unassign option on the
menu is greyed out.

The system displays a message asking you to confirm removal of the asset ID.

Select Yes to confirm.
The system asks if you want to change the status of the asset record to Inactive.

Select Yes or No as appropriate.
The system confirms that the removal is complete and removes the asset ID label from the selected
feature on the map. The feature remains selected.
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How to Assign a Parent Asset

1.

Select a feature on the map that has been assigned an Asset record.
Select the asset that you want to be the child asset.

Select Assign Parent from the Oracle Utilities Work and Asset Management Asset menu.
The Assign Parent window opens.

Enter the Record Type and Asset ID for the Parent Asset.
Click on the Assign button.
The system confirms the assignment of the parent asset.

Click on the OK button.

How to Record Assets on a Service Request

1.

Open the appropriate Service Request record in Oracle Utilities Work and Asset Management.
To use GIS functionality for service requests, you must launch the GIS map from the service request
module.

Select View Map from the Actions list.
You must launch the GIS application from the Service Request record to record assets in this way.

The GIS application launches, opens the map in Data View, zooms in and selects all features with
assigned assets associated to the service request. There can be zero, one or more features selected.

Select additional features on the GIS map with assigned asset IDs.

Make sure to hold down the Shift key as you select additional features if you want the current features
to remain selected. Otherwise, the currently associated assets will be replaced with the new assets you
are selecting,

Select Record Assets under Service Request on the Options menu.
The Record Assets screen displays showing the service request number and the selected assets.

If you did not open GIS from the Service Request record, the Record Assets options is not available.

Click to confirm that you want to record the asset(s).
The system records the assets on the Service Request Asset List view, dividing the percentage split
equally between the assets. Any previous assets that were on this list are replaced.

You may need to click the Refresh icon to update the record with the new asset information.

Open the Service Request record Asset List view in Oracle Utilities Work and Asset Management to
make any changes to the percentage split between assets.

How to Search for an Address

1.

Select Find Address from the Oracle Utilities Work and Asset Management toolbar.
The system opens the Find dialog box below the map.

Enter an exact or a partial address in the Address field.

You can use the “%” wildcard character to substitute for street numbers. For example, you could enter
“% Taylor” (or just “% tay”) to search for all addresses on Taylor Street, or “24% Taylor” to find 242
Taylor, 246 Taylor, 248 Taylor, etc.

Click Search.
The viewer displays a list of the addresses found below the map.

Click on a record number to see that address on the map.
Or click the “Zoom to these records” link to open a map showing all of the found addresses.

How to Search for an Intersection

1.

Select the Intersection Wizard from the Oracle Utilities Work and Asset Management toolbar.
The viewer opens the Find dialog box below the map.

Enter the first street name and click Search.
You don’t need to use the “%” wildcard character as the system will find the string you enter anywhere
in the street name. You can enter “bay” to find Bayou, Bayside, Coquina Bay, etc.
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The viewer opens a list of the street segments matching your search. The exact information shown
varies depending on how your map data is set up.

This search for “bay” returned Bay Street, Bayshore Drive, East Bay Isle Drive, and others.

Click on a record number for the correct street.

In the example above, records 3-6 are for Coquina Bay Drive. Clicking on any of those record
numbers opens the complete listing of all intersections whete Coquina Bay Drive is either the named
street of a crossing street.

Click on a record number to display the map of the intersection.

How to Search for a Parcel

1.

Select Find Parcel from the Oracle Utilities Work and Asset Management toolbar.
The system opens the Find dialog box below the map.

Enter the ID for the parcel you want to find in the Parcel field.
You must enter the entire Parcel ID and cannot use the wildcard. Since Parcel ID numbers are usually
very similar, wildcard searches would typically result in too many records.

Click Find String,
The viewer displays the parcel on the map.

Verify the Parcel ID.
You can verify that the correct parcel was found by checking the Parcel ID number.

Click the Identify tool and then click on the map to display parcel information below the map.

Scroll to the right and confirm the Parcel ID number.
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GIS Implementation

Regardless of which GIS viewer you use, implementation of the Oracle Utilities Work and Asset
Management interface to GIS requires that you map GIS features to the Oracle Utilities Work and Asset
Management sa_asset table then complete additional configuration steps. This document provides sample
generic implementation information to use as a guideline.

Overview

The primary configuration goals are to:

1. Synchronize the GIS Schema with sa_asset
2. Configure the GIS Setup business rule in Oracle Utilities Work and Asset Management
3. Setup the Job Manager in Oracle Utilities Work and Asset Management

Synchronize the GIS Schema with SA_Asset

When new GIS feature data is added to a GIS schema, the Asset ID cross-reference field (SynergenlD) is
left blank. The interface must find all of these new records and create corresponding Oracle Utilities Work
and Asset Management asset records.

To synchronize the tables you must complete the following:

Create database views for the Oracle Utilities Work and Asset Management asset data

Define Constants for the GIS Interface

Create database views for the GIS feature data

Create a database sequence number in the Oracle Utilities Work and Asset Management schema to be

=

used to generate the Asset ID

Once the setup is completed, the interface reads all records from the GIS views, creates a new sa_asset
record based on the GIS view, and updates the SynergenID back in the GIS schema with the new Oracle
Utilities Work and Asset Management Asset ID.

Create the SA_ASSET View

A new view related to the GIS interface must be created. This view is not delivered as part of the base
application so that it can be configured by each customer without fear of having it overwritten by an
upgrade.

The view name must be: SV_GIS ASSET LAYOUT

Note: A view is used for this process to allow the sa_asset table to be modified without affecting the GIS
integration. If the full sa_asset table had been mapped, the views created to map to the GIS feature data
would need to change each time a new column is added to the sa_asset table.
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Synchronize the GIS Schema with SA_Asset

Identify GIS Feature Asset Columns

The view can only contain columns from sa_asset, but should contain a superset of asset information
containing all asset columns from the sa_asset table that meet the following characteristics.

*  Any columns that will be mapped to any of the GIS feature data

*  Columns that are represented as pop-lists on the Asset window in Oracle Utilities Work and
Asset Management

. Columns that are Yes/No indicators in the sa_asset table

*  Columns that are required for the interface

For example, if you are setting up the interface to synchronize GIS Street and GIS Pipe information, you
might want to copy the following fields into the sa_asset table.

Streets Pipes Information

Asset Record Type Record Type

Asset Description Asset Description

Street Number Manufacturer

Street Name Manufacturer Model Number
City

In this example, the new view must contain the following information from both GIS feature tables.
SV_GIS ASSET LAYOUT Columns
Asset Record Type
Asset Description
Street Number
Street Name
City
Manufacturer
Manufacturer Model Number

If you have “n” GIS featute tables to map into the sa_asset table, you must perform the mapping for each
table and then define the superset of information related to all of the features.

Define Constants for the GIS Interface

There are also some constants that are required by the GIS interface. These fields are used to pass
information from the GIS feature tables to the interface.

. The ASSET_ID column must be in this view.
. The ASSET KEY _SEGMENT column must be in this view.

Other Required Columns

There are also other columns that must be in the view because Oracle Utilities Work and Asset
Management requires this information for the Asset screen to display correctly.

SA_ASSET Column Description of Data that will be Required from GIS Views
plant Will be used to default the plant.
asset_status ACTIVE, INACTIVE, PLANNED, or RETIRED. Must be
uppercase.
location_basis FACILITY, ADDRESS, or ADDRESS WITH NODES. Must be
uppercase.
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Synchronize the GIS Schema with SA_Asset

SA_ASSET Column

Description of Data that will be Required from GIS Views

safety_critical_ind
safety_notes_ind
notes_ind

Any single character indicator in the table will be defaulted to Y or
N. These columns are typically presented in the User Interface as
check boxes and usually require a value to display correctly.

future_retirement_ind
radio_ind
air_condition_ind
cruise_control_ind
car_phone_ind
stereo_ind
environmental_ind
health_ind
sent_to_interface_ind

SYSDATE

Will either be set to the keyword USER or a constant such as GIS
INTERFACE. A constant will allow you to easily identify those
records created by the GIS interface.

SYSDATE.

Will either be set to the keyword USER or a constant such as GIS
INTERFACE. A constant will allow you to easily identify those
records created by the GIS interface.

This field will be used to pass the ROWID information for the
GIS feature data. This data will be used to update the GIS Feature
with the new Asset ID cross-reference.

last_update_date

last_update_user

creation_date

created_by

asset_key_segments

Example

The following Create View statement provides a sample of a possible view that can be used by the
interface.

Create or replace view sa gis_asset layout

as

select

plant,asset record type,asset_id,asset status, location basis,
asset key segments,last update date, last update user,
creation date, created by,safety critical ind, safety notes
ind, notes_ind, future retirement ind, radio ind, air_
condition ind,cruise control ind, car phone ind, stereo
ind,environmental ind, health ind, sent to interface ind,
asset_type, asset_desc, street_number,street_name,
manufacturer code, manufacturer model no

from sa_asset

where 1=2

Note: "where 1=2" sets it so that the view does not contain any data other than contain no data other than
the structure of the view. This view is only used for column mapping

Create the GIS Feature Views

Create one new view for each GIS feature table that is being mapped to the sa_asset table. Each of these
views must match the new sa_asset view described above exactly. The interface simply matches column for
column between the two views to synchronize the information.

You only want the GIS feature views to contain the records in the feature table where the cross-reference is
null. You must have a condition in the “where” clause defining this predicate. If this clause is left out, you
will create duplicate assets in Oracle Utilities Work and Asset Management.

You may have to create a database link to access the GIS data if the data exists in a different database
instance.
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Synchronize the GIS Schema with SA_Asset

Example

The example below presents sample street information. This information will be used to match to the SV_
GIS_ASSET_LAYOUT view created above.

GIS STREETS

Name Type

FNODE NUMBER (38)
TNODE NUMBER (38)
LENGTH NUMBER
OBJECTID NUMBER

GID NUMBER
STR_CODE VARCHARZ2 (10)
STR_NAME VARCHAR2 (40)
SEG_OWNER VARCHARZ (20)
SEG_CLASS VARCHARZ (20)
SEG_TYPE VARCHAR2 (20)
ADDR LEFT NUMBER
EVAC_ROUTE VARCHARZ (1)
SYNERGENID VARCHAR2 (20)
GEOMETRY MDSYS.SDO_GEOMETRY

The columns defined above may not all need to be mapped to the sa_asset table. The view below
represents a possible mapping to the SV_GIS_ASSET_LAYOUT view.

Create view sv_gis feature streets

(

plant, asset record type, asset id, asset status, location_
basis, asset key segments, last update date, last update user,
creation date, created by, safety critical ind, safety notes_
ind, notes_ind, future retirement ind, radio_ind, air_
condition_ind, cruise_control ind, car_phone ind, stereo_ind,
environmental ind, health ind, sent to interface ind, asset
type, asseq_desc, street_number, street name, manufacturer_
code, manufacturer model no, parent asset record type, parent
asset_id, department, area, account no

)

as

SELECT

'01', 'S', null,

"ACTIVE', 'ADDRESS', rowid,

sysdate, user,
sysdate, 'GIS INTERFACE',

'N','N','N',
'N','N','N',
'N','N','N",
'N','N', 'N'
'STREET', 'Street Segment from GIS: '||str codel|' '||str_

name, str code,

str name, null, null,

'sS', '4507', 'PUBLICWORK', 'STREETS', '123-000-456"'
from gis schema.gis_streets

where SynergenID is null

Literals Note that may of the parameters in the views are hard coded to literals.
This allows you to apply your local mapping requirements to the fields in
question.

Asset_desc Note that the asset_desc field is passed as a combination of literals and

database columns. You may create any combination of information
needed to represent the GIS data.

Rowid Rowid is always passed into the asset_key_segments column. ROWID
must be passed in the asset_key_segments column.

Null Columns Some fields are passed as null values. These are often the columns in the
view that relate to data for a different GIS feature table. In this example,
manufacturer_code and manufacturer_model_no do not apply to streets
so are passed as nulls in this view.
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Configure the GIS Business Rules

gis_schema This contains the name of the schema that owns the GIS feature table.
Note that this may have to be shown as a database link if the feature table
is in a database instance different than the Oracle Utilities Work and Asset
Management schema.

parent_asset, The parent asset information and the accounting information are typically

account info the same for every feature in a GIS layer. This information may be
passed in as literal strings based on data from Oracle Ultilities Work and
Asset Management.

SynergenlD This is the name of the column that is added to the GIS Feature table as a
cross-reference to the sa_asset Asset ID.

Note that you only want this view to contain the records in the feature
table whete the cross-reference is null. If this clause is left out, you will
create duplicate assets in Oracle Utilities Work and Asset Management.
SynergenID is used as an example here but may be named any name you
want. If you change the column from SynergenID, you will also have to
configure the GIS integration to look for the new column name.

Configure System Generated Asset ID

The Asset ID must be generated automatically using the Sequence Number module in the Oracle Utilities
Work and Asset Management Administration Subsystem. The interface will not work correctly without the
sequencing enabled.

The following sequence number must be created in the Oracle Utilities Work and Asset Management
schema.

create sequence sseq gis interface start with 1

Configure the GIS Business Rules

GIS Setup Business Rule

The GIS Setup business rule controls the type of GIS viewer used for your organization and defines the
additional settings required to enable the GIS viewer and functionality.

Select one type of GIS viewer as the ACTIVATED GIS OPTION then configure settings in the columns
next to the indicated rule keys for that viewer. Only the viewer that is selected as the activated option needs
to be configured.

Rule Key Activated GIS Description

ACTIVATED GIS OPTION |N/A Specifies the GIS System that requests from
Oracle Utilities Work and Asset Management
will be sent to.

AUTODESK1 VIEWER AUTODESK1 Specifies the URL to the

value 4 SynergenMapViewer.asp page. This is a
Oracle Utilities Work and Asset Management
web page that processes the HTTP GIS
Integration request

DISPLAY CHILD ASSETS  |all A “YES” or “NO” value indicating if the
selected Asset and its Children Assets will be
displayed on the map or only the selected
Asset will be displayed on the map.

ESRI1 ALT SEARCH FIELD [ESRI1 An optional, client-specific search field

value 1
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Configure the GIS Business Rules

Rule Key Activated GIS Description

ESRI1 DSN value 1 ESRI1 The Data Source Name that will be used
when configuring the ODBC connection on
the client’s workstation.

ESRI1 GIS SEARCH FIELD [ESRI1 The map search field that will be used to
value 1 store the Asset ID.
ESRI1 INITGIS value 4 ESRI1 The file path and folder where the Oracle

Utilities Work and Asset Management GIS
program is installed on the client’s
workstation.

example is c:\program
files\SynergenGIS\INITGIS.EXE

ESRI1 MAP value 4 ESRI1 The location and file name of the map (mxd).
example
C:\GISData\syntropolis\syntropolis. MXD
ESRI1 MIN SCALE FACTOR |ESRI1 Minimum scale factor (number) that the map
value 1 will be allowed use.
ESRIT PRINT VIEW value 1 |ESRI1 View used when the map is printing
(LAYOUT/DATA).
ESRI1 TRACE value 1 ESRI1 Used only for problem tracking (ON/OFF)
ESRI1 VIEWER value 4 ESRI1 The file path and location of the ESRI viewer
that is installed on the client’s workstation
INTERGRAPH1 VIEWER [INTERGRAPH1 The path and file name of the map viewing
value 1 and value 2 tool.
Example:

http://servername/website/viewername/Sy

nergenMapViewer.asp
>

ORACLE1 VIEWER value 4 |ORACLE1 The configuration file (cfg) containing GIS
preferences.

Example cfg=honolulu.cfg

GIS Asset Interface

This rule shows the list of GIS Views to be processed by the GIS Asset Interface. The GIS View must
match SV_GIS_ASSET_LAYOUT. GIS View records will be copied directly to SA_ASSET. GIS Table
will be updated with the newly created Asset ID (ASSET_RECORD_TYPE - ASSET_ID).

WIFP_GIS_ASSET uses this rule to execute the mapping between GIS data and Oracle Utilities Work and
Asset Management Assets.

GIS Specification Interface

This rule shows the list of GIS Views to be processed by the GIS specification interface. The GIS View
must match SV_GIS_SPECIFICATION_LAYOUT. GIS View records will be copied directly to SA_
SPECIFICATION. Then the GIS Table will be updated with the newly created Specification ID
(SPECIFICATION_RECORD_TYPE - SPECIFICATION_ID).

The GIS View must contain SYNERGENID. All other fields should have the following format: "spec_
seq_no-" | | GIS_FIELD Example: "1-" | | pipe_length

SAIF_GIS_SPECIFICATION_XREF uses this rule to execute the mapping between GIS data and Oracle
Utilities Work and Asset Management Specifications.

Control GIS Settings through the User Profile

Users can also set the ACTIVATED GIS OPTION key name in the User Profile to provide access to
different GIS viewers. Since there are several configuration and data requirements needed to enable

GIS - GIS Implementation 21
User Guide for Release 1.8.1.5 Doc v1 rev.0 11/17/10


http://servername/website/viewername/SynergenMapViewer.asp

Uninstalling a GIS Product

accurate and useful GIS functionality, user specific alteration of this setting is not recommended. However,
it can be used if testing or other non-production use needs to be completed.

Set up the Job Manager

The final configuration step is to add the interface to the job manager for execution.
Open the Job Manager module and create a new batch job with the following parameters:

wifp gis asset.gis asset (job number, plant, gis xref column);

job_number This is the Oracle Utilities Work and Asset Management Job Number assigned by
the Job Manager when a new job is entered into the scheduler.

plant This is the plant code that is related to the Asset data being created.

gis_xtef_column This is the name of the column in the GIS Feature tables that is used to store the

asset cross-reference. It is typically known as SYNERGENID but may be
changed here to be any name.

Note that changing the name from SYNERGENID here and in the GIS feature
tables also requires configuration changes to the GIS integration and related map
viewer configuration files.

Example: wifp gis asset.gis asset (85, '0Ol', 'SYNERGENID');

Add a GIS Viewer Link to the Home Page

(Optional) It may be beneficial to users to have a GIS Viewer link added to their home page so that they
have easier access to the functionality. If you use Oracle Viewer as your GIS program, the link is
automatically available in the Actions list if the GIS VIEWER function is added to uset’s responsibilities.

1. In the Links component on the home page, click Options.
If you do not have the Links component, add it using the Personalize Page link.

2. Click Advanced Edit > Add.
Enter the title “Open GIS Viewer” or similar.
4. Enter the link
“http://[setvername]:[port] /synetgen/OpenGISViewet.jsp”

e

where “servername” and “port” are the approptiate values for your server and port.

Example: http://paris:1710/synergen/OpenGISViewer.jsp

5. Click Finish > Save >Close.

6. Add the server as a trusted site if necessary.
You can do this by clicking the Charts icon on the home page and then clicking the “Add Chart Server
as a Trusted Site” link.

Uninstalling a GIS Product
1.  Start the GIS tool.
This may be ArcMap, ArcIMS, ArcGIS\, etc.

2. Open the map used for the integration.
3. Remove the custom menu.
Select Customize from the Tools menu.

Click on and delete the menu and all of its submenus.

4. Delete the GIS Seatch Field from its data table(s).
5. Remove and delete the ODBC DSN for the Oracle Utilities Work and Asset Management database.

GIS - GIS Implementation 22
User Guide for Release 1.8.1.5 Doc v1 rev.0 11/17/10



GIS Integration Application
Programming Interface (API)

Integrations between Oracle Utilities Work and Asset Management and GIS systems are two-way
communications where Oracle Utilities Work and Asset Management sends information to the GIS system
and the GIS system sends information back to Oracle Utilities Work and Asset Management. This
communication is completed via HTTP URL requests made to the Oracle Utilities Work and Asset
Management browser.

This document describes the application programming interface used in these integrations.

Supported Systems
Oracle Utilities Work and Asset Management can currently be integrated with the following GIS products:
¢ AutoDesk - MapGuide
AutoDesk's MapGuide, a web-based system.
e ESRI - ArcMap
ESRI's ArcView desktop software suite. In this interface, the Oracle Utilities Work and Asset

Management application uses a Oracle Forms webutils programs to execute the GIS software
running on the client machine.

Note: ARCView consists of several desktop applications, including ARCMap. Only ARCMap is
required for the Oracle Utilities Work and Asset Management integration.

*  ESRI - ArcIMS
ESRI's ArcIMS System. This is a web-based system tequiring an ArcIMS map server.

¢ ESRI ArcGIS Viewer
ESRI’s ArcGIS system. This is a web-based system requiring an ArcGIS map server.

*  Intergraph - Geomedia)
Integraph's Geomedia Web Enterprise software suite, a web-based GIS viewer system.

*  Oracle GIS Viewer
Oracle's Spatial viewer, a web-based viewer. The viewer page is currently embedded into the
Oracle Utilities Work and Asset Management application, although an Oracle Spatial MapViewer
server is still required.

These integrations use common Oracle Utilities Work and Asset Management components and share the
same tables, actions, views, and stored procedures. A single business rule, GIS Setup, is used to specify
which GIS product is deployed and to specify additional parameters as needed.

Integration Points

As discussed, GIS integrations involve a two way communication between Oracle Utilities Work and Asset
Management and the GIS system.
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Oracle Utilities Work and Asset Management to GIS

Users can select View GIS or PRint GIS Map from the Actions list in one of the following modules to
launch the GIS viewer:

*  Asset (ASSET): The asset currently displayed in the Asset module.

*  PM Master (PMMASTER): All assets associated with the work orders created from the
current pm_master_no record's benchmark_no.

. Service Request (SERVREQ): All assets associated with the current service_request_no.

*  Work Order (WORKORD) or Benchmark Work Order (BENCHWO): All assets
associated with the current work_order_no.

. Work Otrder Task (WOTASK): All assets associated with the current work_order_no and
work_order_task_no.

*  Work Request (WORKREQ): All assets associated with the current work_request_no.

Requests
Requests from Oracle Utilities Work and Asset Management to the GIS system depend on the underlying

architecture of the GIS System. Browser-based solutions require HTTP URL requests whereas desktop
computer software requires specialized arguments passed to the GIS software executable.

GIS to Oracle Utilities Work and Asset Management

The GIS system opens Oracle Utilities Work and Asset Management when one of the following options is
selected:

. View Asset

. View PM Master

. View Service Request
. Record Assets

. View Work Order

. Create Work Order

*  View Work Request

*  Create Work Request

Requests
Requests to navigate to a specific Oracle Utilities Work and Asset Management record or to perform a

specific action are made form the GIS System to a Oracle Utilities Work and Asset Management servlet.
This is done by using the existing Oracle Utilities Work and Asset Management browser window with
specific URL requests depending on the type of request.

Add-Ons
Oracle Utilities Work and Asset Management GIS System Integrations include add-on packages to the

web-based GIS Systems. These add-ons provide embedded Oracle Ultilities Work and Asset Management
menu options for querying the Oracle Utilities Work and Asset Management data and sending requests to
Oracle Utilities Work and Asset Management. When the user selects one of these menu options, the system
displays a dialog box to where the user chooses a single item. Then the request is made to the Oracle
Utilities Work and Asset Management application. This request is in the form of an HTTP URL request
that targets the main Oracle Utilities Work and Asset Management browser window.

Opening Application Windows

In the integration process, the Oracle Utilities Work and Asset Management application may or may not
already be open. To complete the integration cycle, the integration code must find any existing Oracle
Utilities Work and Asset Management application SIA window so that the Oracle Utilities Work and Asset
Management modules can open the GIS System window, and the GIS System can open the same Oracle
Utilities Work and Asset Management module.

This “find” is done using the JavaScript command “window.open()” using the following algorithm for the
window name.

"synMain" + username + " " + forms tnsname + " " + user entry
number
where:
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username = the user logged into the Oracle Utilities Work and Asset Management application

forms_tnsname = the configproperties configuration setting associated with the
Forms database TNS name. The TNS name corresponds to the database TNS name used by the Oracle
Forms portion of Oracle Utilities Work and Asset Management.

user_entry_number = a sequential number that starts at 1 and increments every time the same username
logs into the Oracle Utilities Work and Asset Management application. This number is reset to 1 when a
maximum threshold is reached. The threshold is set within the config.properties file as "max_user_
windows"

Example

synMainLELLISON PROD1 1
If an existing Oracle Utilities Work and Asset Management application window is not
found, the JavaScript window.open() command starts a new window before opening the requested form.
The user must to logon to the Oracle Utilities Work and Asset Management application unless the "Save
My Logon" option is enabled.

HTTP URL Requests
The following sections detail the URL requests used for the Views accessed from the GIS map.

sia_url = the HTTP path to the Oracle Utilities Work and Asset Management application derived from the
sa_internet_integration Oracle Utilities Work and Asset Management table.

View Asset
The format of the URL request is as follows:

sia url + "DrillDown?tgt=Drilldown&drilldownItem=asset
idéprimekey name l=asset record type&asset record type=" +
asset record type value + "&primekey name 2=asset id&asset
id=" + asset_id_value + "&sRp=1

asset_record_type_value = the asset_record_type of the asset selected from the integration dialog
asset_id_value = the asset_id of the asset selected from the integration dialog,

View PM Master
The format of the URL request is as follows:

sia url + “DrillDown?tgt=Drilldown&drilldownItem=pm master
noéprimekey name l=pm master no&pm master no=" + pm master no_
value + "&sRp=1";

pm master no_ value = the pm_master_no selected from the integration dialogs.

View Service Request
The format of the URL request is as follows:

sia url + “DrillDown?tgt=Drilldowné&drilldownItem=service
request no&primekey name l=service request no&service request
no=" + service_request_no_value + "&sRp=1";

service_request_no_value = the service_request_no selected from the integration dialogs.

Record Assets
This process starts with a Service Request record in the Oracle Utilities Work and Asset Management

application. From the module menu, the user selects “View GIS Map” to display the GIS System map page.
After selecting all assets to assign to the service request, the user clicks the "Record" button to and the
integration architecture executes the “sdbp_gis_record_assets” stoted procedure passing the plant, service_
request_no, list of assets, and the username.

After the procedure is called, the service request page is redisplayed using the following URL request to the
Oracle Utilities Work and Asset Management application.

sia url +
“DrillDown?tgt=Drilldowné&drilldownItem=service request
no&primekey name_l=service_ request_no&service_ request_no=" +
service_request no_value + "&sRp=1";
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service_request_no_value = the service_request_no originally selected in the Oracle Utilities Work and
Asset Management application.

View Work Order
The format of the URL request is as follows:

sia url +
“DrillDown?tgt=Drilldowné&drilldownItem=work order no&primekey
name_l=work order_no&work order no=" + work order no_value +
"&primekey name 2=work order task no&work order task no=" +
work order task no_value + "&sRp=1";

If the Work Order is in HISTORY status, the following URL is used instead

sia url +
“DrillDown?tgt=Drilldowné&drilldownItem=work order no&primekey
name_l=work order_no&work order_ no=" + work order no_value +
"&primekey name 2=work order task no&work order task no=" +
work order task no_value + "&work status=HISTORY&sRp=1";
work_order_no_value = the work_otrder_no selected from the integration dialogs

work_order_task_no_value = the work_order_task_no from the integration dialogs

Create Work Order
Selecting this option will display all the assets selected, and allow the user to enter the Work Description

value for the new work order. Clicking the "Create" button will execute the "sdbp_gis_create_wo" stored
procedure passing the plant, list of assets (asset_record_type and asset_id), work description, and the
current username of the Oracle Utilities Work and Asset Management user.

Once created, the user is navigated to the Work Order module of the Oracle Utilities Work and Asset
Management application (WORKORD) using the following request URL.

sia url +

“DrillDown?tgt=Drilldowné&drilldownItem=work order

no&page=WORK_DEMAND&work demand type=Z&primekey name l=work

order_noé&work order no=" + work_order_no_value + "&sRp=1";
work_order_no_value = the work_order_no selected from the integration dialogs.

View Work Request
The format of the URL request is as follows:

sia url +
“DrillDown?tgt=Drilldowné&drilldownItem=work request
no&primekey name l=work request no&work request no=" + work_
request no_value + "&sRp=1";

work_request_no_value = the work_request_no selected from the integration dialogs.

Create Work Request
Selecting this option will display all the assets selected, and allow the user to enter the Work Request

Description value for the new work request. Clicking the "Create" button will connect to the database using
the configured ODBC DSN, and execute the "sdbp_gis_create_wt" stored procedure passing the plant, list
of assets (asset_record_type and asset_id), work request description, and the current username of the
Oracle Utilities Work and Asset Management user.

Once created, the user is navigated to the Work Request module of the Oracle Utilities Work and Asset
Management application (WORKREQ) using the following request URL.
sia url +
“DrillDown?tgt=Drilldown&drilldownItem=work request
no&primekey name l=work request no&work request no=" + work_
request no_value + "&sRp=1";
work_request_no_value = the work_request_no selected from the integration dialog,

Browser Based Systems
All of the integrated GIS systems are browser based except for ESRI ArcMap.
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HTTP URL Parameters

Configuration settings in the GIS Settings business rule determine which interface is active, and define the
url to open the integrated GIS viewer.

The parameters indicated below are used for the integration when AUTODESK1, ESRI2, or
INTERGRAPHI are activated. The "ORACLE1" (Oracle Spatial integration) uses the same parameters
except the "ID".

Parameter Description

ID Encrypted username/password of the current Oracle Utilities Work and Asset
Management user

aid Asset key list where the asset key is the asset_record_type and asset_id
separated by the "-" character. This list may include child assets if the
DISPLAY CHILD ASSETS setting of the GIS SETUP business rule is
activated. Individual asset keys are enclosed by starting and ending quote (")

nn

characters and separated by the "," character. All characters are in uppercase.

cnt Count of assets in the asset list (aid)

plt Plant of the current logged in Oracle Utilities Work and Asset Management
user

prt Y if the "PRINT GIS MAP" action was selected

Desktop Based System

The only GIS integration that uses a desktop interface is ArcMap.

When the “View GIS Map” or “Print GIS Map” actions are selected from Oracle Utilities Work and Asset
Management, the integration architecture launches the desktop GIS software passing the current asset
values.

Desktop Software Parameters

As noted in the business rule description, the ESRI INITGIS value indicates the executable program that
will be called by the Oracle Utilities Work and Asset Management application.

The following parameters are passed and listed in name/value pairs with the name and value separated by
the “=" sign. Individual name/value pair are separated by the space charactet.

Note: the length of the entire parameter string is limited to 2000 characters

Parameter Description

usr from the current Oracle Utlities Work and Asset Management application uset's
username. This is needed so that the desktop software can make database queries
with the appropriate permissions.

pwd from the current Oracle Utilities Work and Asset Management application uset's
password. This is needed so that the desktop software can make database queries
with the appropriate permissions.

dsn ESRIT DSN business rule value

dap ESRI1 MAP business rule value

gsf GIS Search Field from ESRIT GIS SEARCH FIELD business rule value

VWI ESRI1 VIEWER business rule value

pvw ESRI1 PRINT VIEW business rule value

msf ESRI1 MIN SCALE FACTOR business rule value

aid asset key list where the asset key is the asset_record_type and asset_id separated

by the "-" character. This list may include child assets if the DISPLAY CHILD
ASSETS setting of the GIS SETUP business rule is activated. Individual asset

keys are enclosed by starting and ending quote (") characters and separated by the

nn
>

character. All characters are in uppercase.
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Parameter Description

plt plant of the current logged in Oracle Utilities Work and Asset Management user
prt Y if the "PRINT GIS MAP" action was selected
1dt for a request with a single asset, this is the truncated version of the asset

description with all spaces replaced by the "~" characters so that individual
words are not mistaken for separate parameters.

Example
c:\program files\SynergenGIS\INITGIS.EXE aid=M-1520 plt=01

ldt=Main~Water~Pipe
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